Microsoft Word
ذخیره سازی  ، باز کردن  و ایجاد فایل جدید

ایجاد کردن یک فایل جدید:
روش ها :
1-File > New > Blank document

2-انتخاب دکمه New  از نوار ابزار

3-Ctrl+N
یعنی کلیدهای  Control و N  را باهم فشار دهید.
ذخیره کردن یک فایل :
1-File >> Save As

- توجه : در صورتی که هنگام جستجو در منو ها ، گزینه مورد نظرتان را مشاهده نمی کنید منو را Expand  (بزرگ) کنید.

2-انتخاب دکمه  Save  از نوار ابزار
3-Ctrl+S
- اسم پیش فرض فایل ها    document  خواهند بود و پسوند آن ها .doc 
باز کردن یک فایل :
1-File > Open
2-انتخاب دکمه Open   از نوار ابزار

3-Ctrl+O
تنظیمات صفحه :
Page layout >> Page setup
Margin حاشیه
Gutter  شیرازه

Orientation:   portrait (عمودی), landscape (اففی)

Paper size : ابعاد کاغذ
خط کش ها:

view >> ruler     فعال یا غیر فعال کردن خط کش ها 
مرز رنگی قبل از خط کش ها نشان دهنده حاشیه صفحه است.
قالب بندی متن:
1-  با استفاده از نوار ابزار فرمت 

برای افزایش یا کاهش  یک واحد ، یک واحد در سایز فونت :
Ctrl + [
Ctrl + ]

Blod   Ctrl + B
Italic  Ctrl + I

Under line   Ctrl + U

Align:
Center وسط چین    Ctrl + E

Left  چپ چین  Ctrl + L

Right  راست چین Ctrl + R

Justify طراز از دو طرف Ctrl + J

- توجه : در word برای اعمال هرگونه تغییرات باید ابتدا متن یا شی مورد نظر را انتخاب کرد

قالب بندی دقیق متن 
Home > Font    (Ctrl + d).
Font Tab:

Latin text   فونت مربوط به متن های لاتین 

Complex script    فونت های مربوط به زبان فارسی
Font color  رنگ قلم

Underline style    نوع زیر خط 
Underlin color رنگ زیر خط
Effects  
Strike through  خط زدن
Double Strike through  خط زدن مضاعف
Super script متن انتخاب شده بالاتر از خط زمینه قرار می گیرد
Sub script متن انتخاب شده پایین تر از خط زمینه قرار می گیرد

Shadow سایه دار شدن متن
Out line تو خالی کردن فونت
Emboss  برجسته کردن فونت
Engrave  تو رفتگی فونت  
Small Caps   بزرگ کردن اندازه اولین حرف
All caps   بزرگ کردن حروف

تنظیمات مربوط به پاراگرف:
Format > Paragraph
Alignment تراز بندی
دو نوع تراز بندی وجود دارد. تراز بندی  چپ  برای متن های لاتین و راست برای متن های فارسی

- Word جهت متن  (direction) را به صورت اتوماتیک تعیین می کند.

Indentation تو رفتگی
Before text  تو رفتگی از سمت چپ
After text تو رفتگی از سمت راست


Specianl 


Spacing
چند نکته قبل از شروع به تایپ !
· در صورت تایپ فارسی حتما  direction را راست به چپ (right to left) و align را راست (right)  بگذارید. 
· برای ایجاد یک پاراگراف جدید از کلید Enter استفاده کنید. پس در یک پاراگراف برای رفتن به خط بعد از کلید Enter استفاده نکنید زیرا  word آن خط را یک پاراگراف تلقی می کند. برای رفتن به خط بعد از Shift+ Enter استفاده کنید.
· برای شکست صفحه  (رفتن به صفحه جدید) از Ctrl+ Enter استفاده کنید.

روش های کپی :
ابتدا متن مورد  نظر را انتخاب می کنیم (highlight)   ، سپس :

روش 1 :  راست کلیک کرده  و Copy  را انتخاب می کنیم.

روش 2: از منو Home  ، گزینه copy  را انتخاب می کنیم.
(روش سریع )روش 3 : Ctrl+ C

برای  paste  کردن متن کپی شده :
1- راست کلیک کرده  و paste  را انتخاب می کنیم.

2- از منو Home  ، گزینه paste را انتخاب می کنیم.
3- (روش سریع ) Ctrl + V

روش های انتقال (Cut) همانند کپی است اما متن انتخابی به جای کپی ، جابه جا می شود.

برای عمل انتقال می توان مستقیما متن انتخابی را Drag کرد. (کشید)
Insert picture  
Insert > picture > from file
برای وارد کردن تصویر از این گزینه استفاده می کنیم. با وارد کردن تصویر نوار ابزار picture فعال می شود.

Color 

ایجاد کادر و پس زمینه برای صفحه 

Page layout > Page Borders 
توجه : در تب Borders  تنطیمات برای یک پاراگراف انجام می شود اما در تب page border  تنظیمات برای تمام صفحات انجام می شود.
ترسیم جدول 

Insert > Table
نکته : قبل از رسم جدول ، جهت متن را تعیین کنید ، در غیر این صورت جدول چپ چین می شود !
برای حرکت بین خانه های جدول 

برای حرکت به سمت جلو از TAB استفاده کنید و برای برگشت به خانه قبل از shift+Tab استفاده کنید.

توجه : می توانید با کلید های جهت دار نیز اینکار را انجام دهید.

به هریک از خانه های جدول یک سلول می گویند.

برای انتخاب یک یا چند سلول ، وارد سلول مورد نظر شده ، با کشیدن موس سلول ها را انتخاب می کنیم.

حذف سلول ها 

روی سلول مورد نظر راست کلیک کرده و delete cells را انتخاب می کنیم
ادغام کردن سلول ها 

ابتدا سلول های  مورد  نظر را انتخاب کرده ، سپس راست کلیک کرده ، گزینهcells  merge را انتخاب می کنیم.

تقسیم کردن سلول ها

در خانه مورد نظر قرار گرفته ، کلیک راست و سپس spilt cell را انتخاب می کنیم ، پنجره split باز شده ، تعداد سطر ها و ستون ها  را وارد می کنیم تا سلول به آن تعداد تقسیم شود.
Microsoft Excel

اصطلاحات مربوط به اکسل

فيلد : در اکسل معمولاستون ها را فيلد می نامند .
رکورد : در اکسل سطر ها را رکورد می نامند .
کاربرگ : يا همان  SHEET  مجموعه ای از رکورد هاست.  
فايل  : يا همان  WORKBOOK مجموعه از کاربرگ هاست .
           
تغييرساختاركاربرگ

افزودن سطر وستون براي اضافه كردن يك سطر و يك ستون دريك كاربرگ كافي است ستون بعد آن را انتخاب كرده برروي سرستون راست كليك كرده گزينه Insert را کليک کرده , ستون جديد درج ميشود براي سطر نيز با همين روش .

براي حذف يك ستون ويك سطر ستون مورد نظر را انتخاب راست كليك گزينه Delete را انتخاب ميكنيم , ستون مورد نظر حذف ميشود .

استفاده از AUTOFILL 

ابزار AutoFill                      
 Autofillيا پركننده خود كار : هنگامي كه به پايين يك سلول نزديك ميشويم يک مربع کوچک سياه رنگ ديده می شود که اگر ماوس را به آن نزديک کنيم , اشاره گر ماوس به صورت يك صليب نازك سياه رنگ ملاحظه ميشود , در اين حالت اگر چپ كليك ماوس را پايين نگه داشته وبه سمت اطراف حركت كنيم    Autofillفعال گشته , دو نوع عمليات انجام ميدهد 
الف- كپي                ب- توسعه
 
 در حالت اول داده ها تكرار ميشود و در حالت دوم عمليات توسعه داده ها صورت مي پذيرد . 

مثال : اگر در يك سلول عدد  1 نوشته شود وكاربر Autofill آن سلول همراه با كليد Ctrl را فعال ساخته و به سمت پايين حركت كند , يك علامت + در بالاي Autofillملاحظه ميگردد  وعمليات توسعه  صورت مي پذيرد :        

    
 مثال2: اگر دردوسلول پياپي اعداد 1 و 3 نوشته شوند سپس هردوسلول انتخاب شدهAutofill آن را پايين نگه داريم وبه سمت پايين حركت كنيم سري زير حاصل ميشود :
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 از  Autofilllمي توان براي كپي روزهاي هفته ،ماههاي سال وتاريخ نيز استفاده كرد.
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نقل و انتقال داده ها در اکسل
روشهاي كپي داده ها در اكسل

به چند روش ميتوان داده ها را درون اكسل كپي كرد :

روش اول  ابتدا سلولهاي مبداء را انتخاب كرده سپس با استفاده از راست كليك گزينه Copy را نتخاب كرده به مقصد مي رويم و در انتها گزينه Paste را انتخاب ميكنيم .

روش دوم استفاد ه ازنوار منوی  Home : ابتداء سلولهاي مبدا را انتخاب كرده از منوی Home ,گزينه  Copy را برمی گزينيم و در آخر به مقصد رفته گزينه Paste را می فشاريم .

روش سوم استفاد ه از نوار ابزار : سلولهاي مبداء را انتخاب کرده  با استفاد ه از كليد كپي آنها را به حافظه مي سپاريم و سپس به مقصد رفته كليد  Pasteرا فشار مي دهيم .
روش چهارم استفاد ه از چپ كليك مآوس يا  Drag: ابتداء سلولهاي مبدا را انتخاب كرده , با ماوس به حاشيه آن نزديك شده تا يك فلاش سفيد رنگ به همراه يك صليب آشكار گردد . در اين حالت كليد Ctrl و چپ كليك ماوس ر ا پايين نگه داشته و به مقصد حركت ميكنيم  , سپس چپ كليك موس و  Ctrlرا رها مي كنيم  .تمام مراحل فوق جهت انجام عمليات  انتقال نيز صادق است  , تنها در اين حالت كليد Ctrl  لازم نيست .

۱- انتخاب پیوسته (ماوس) : حرکت با چپ کلیک

۲- انتخاب پیوسته ( صفحه کلید) :       SHIFT + کلید های جهتی
۳- انتخاب گسسته (ماوس)  :  چپ کلیک + کلید کنترل
۴- اتخاب گسسته ( صفحه کلید) :   SHIFT + F8

براي انتخاب يك ستون يا يك سطر كافي است برروي سر ستون يا سر سطر , چپ كليك كرده و براي انتخاب يك كاربرگ (Sheet ) برروي سلول كاربرگ          چپ كليك ميكنيم (A  Ctrl +) . 
ويرايش داده ها
براي حذف يا ويرايش دادهها در سلول به چهار روش اقدام ميكنيم :

1- سلول مورد نظر را انتخاب كرده كليد  Deleteرا فشار مي دهيم تا داده فعلي حذف شده و سپس داده جديد را تايپ ميكنيم . 

2- برروي سلول مورد نظر رفته , داده جديد را تايپ مي كنيم  .

3- با استفاده از كليد   F2, مكان نما در سلول فعال شده وكاربرقادر به ويرايش داده ها در سلول ميباشد .

4- با استفاد ه از كليك ماوس بروي سلول مورد نظر رفته عمليات دوبار كليك را انجام داده مكان نما فعال ميگردد وشبيه عمليات کليد   F2 ,كاربر قادر به ويرايش داده ها در سلول ميباشد .

محاسبات در اكسل
الف : فرمولها 




ب : توابع

فرمول ها
براي انجام محاسبات ساده در اكسل از فرمولها استفاده ميكنيم هر فرمول از قسمتهاي زير تشكيل شده است
 1- علامت مساوي
 2- متغيرها
 3- عملگرهاي رياضي                                                                          

=3+2
=(-4)^8 * 19 –13.23

=77.02 /14.9

 
انواع عملگرهای رياضی 

+ : جمع   - : تفريق         / : تقسيم * : ضرب     ^ : توان  % : درصد&    ( به هم پيوستن دو کلمه يا دو رقم )

 مثال: عمليات سمت چپ در سلول نوشته شده و حاصل پس از فشردن کليد Enter  مشاهده می شود .

	حاصل
	عمليات

	3
	=1+2

	-1
	=1-2

	5
	=10/2

	10
	=5*2

	8
	=2^3      عدد دو به توان عدد سه

	1
	=5%*20     پنج درصد عدد 20

	ali hosein
	=”ali”&”hosein”


متغيرها ميتواند آدرس نيز باشند  .

مثال1: اگر در سلول A1 عدد  10 و در سلول  A2عدد 5 را نوشته شده باشند و در سلول A3 معادله زير را بنويسيم      =A1+A2  
 جواب 15 در A3 نمايان خواهد شد .
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مثال2 :در جدول فوق براي انجام محاسبات جمع ومعدل گيري بايد در ستونها‏ي مورد نظر فرمولهاي صحيح را ياداشت کرد. [image: image4.jpg]D i c i B i A
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لازم به ذکر است که فقط سلول اول فرمول نویسی شده و با استفاده از Autofill بقیه سلول ها پر می شوند.            
آدرس دهی سلول ها در فرمول نویسی
انواع آدرسها 
1-آدرس نسبي :
 اين آدرس همان آدرس معمولي در اكسل مي باشد كه با انجام عمليات  Copyو Paste آدرس درون فرمول ها تغيير كرده وبه نسبت مكان مورد نظر تغير شكل مي دهد 
مثال: اگر در سلول  A5   فرمول روبرو نوشته شود و سپس آنرا به سلول A6   کپی کنيم ,



=G1*5


نتيجه چنين خواهد شد 



=G2*5
ويا اگر اين فرمول را كپي كرده وبه 4خانه پايين ترببريم وPaste را کليک كنيم فرمول به شكل زير تغيير ماهيت ميدهد: 









                                          =G5*5
 
2- آدرسهاي مطلق :

براي جلوگيري از تغييرات در فرمولها از نوع دوم آدرس استفاده ميكنيم اين آدرسها آدرسهاي مطلق ناميده ميشوند ودليل آن اين است كه با تغييردر كاربرگ وسلولها‏ آدرسها‏ي مطلق تغيير نمي‏يابد جهت ايجاد يك آدرس مطلق از علامت $ (دلار )استفاده ميكنيم كافي است كه پشت نام ستون وشماره سطر علائم $بگذاريم  .
 مثال:








            =$F$2+A5
اگر آدرس فوق را در چهار سلول پايين‏تر كپي كنيم به شكل زير تغيير مي كند :


















                 
=$F$2+A9                              

  3- آدرسهای تركيبي :
هرگاه كاربر بخواهد سطريا ستون را ثابت نگه دارد از آدرسهاي مخلوط يا تركيبي استفاده مينمايد براي ايجاد يك آدرس تركيبي يا مخلوط باز از علامت $استفاده ميكنيم براي ثابت نگه‏داشتن ستون علامت $رادر پشت حرف ستون قرار ميدهيم وبراي ثابت نگه‏داشتن سطر علامت$ را در پشت شماره سطر

 مثال:
       =$H2  به مفهوم ثابت بودن ستون  Hاست با قابليت تغيير  رديفها 
 و=H$2                 به معناي قابليت تغيير ستونها وثابت بودن شماره سطر 2   است 

توابع در اكسل
جهت انجام عمليات تكراري وپيچيده از توابع تعريف شده دراكسل استفاده ميكنيم.

قسمتهاي مختلف يك تابع :

هر تابع از سه جزء اساسي تشكيل شده است 

1-علامت مساوی

2- نام تابع 

3- پارامتر تابع 

 مثال :  تابع    =SUM(A3:B10) 
مفهوم علامت دو نقطه در تابع کلمه تا می باشد .
که در آن کلمه  SUM  نام تابع  و   A3:B10   پارامتر تابع است  . این پارامتر محدوده عملیات تابع را مشخص می کند و مفهوم آن اینست که اعداد موجود در محدوده  A3   تا B10  را با هم جمع می کند .

 
مثال : جدول زير را کامل کنيد :
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دسته بندی  توابع در اکسل 

در اكسل توابع به يازده دسته مختلف تقسيم ميشوند .

اين يازده گروه عبارتند از : 
	Most Recently used
	توابعي كه اخيراٌمورد استفاده قرار گرفته‏اند

	All
	تمامي توابع موجود در اكسل

	Financial
	ما لي 

	Date & time
	تاريخ وزمان

	Math & Trig
	رياضي ومثلثات

	Statistical
	آماري 


	Lookup & reference   
	آدرسها وجستجو


	Database
	بانك اطلاعاتي

	Text
	متن

	Logical   
	منطقي

	Information

	اطلاعات


توابع پرکاربرد در اكسل
  تابع  SUM










 شكل تابع                 (محدوده)=SUM


شرح تابع :اين تابع پارامترهاي موجود (محدود ‏ه هاي موجود )رابايكديگر جمع ميكند 

مثال:








     =Sum(C10:C231)    اين فرمول مجموعه‏اي از سلولهاي  C10تا  C231رابا يكديگر جمع ميكند .
 محدوده C10 تا C231 محدوده‏اي از آدرسها مي باشد كه با علامت (:) مشخص شده است . 

تابع AVERAGE


شكل تابع (محدوده)=Average
شرح تابع :ميانگين دادههاي موجود در محدوده را محاسبه ميكند .

           






(=Average(F5:G11  ميانگين 
میانگین سلولهاي  F5تا  G11را محاسبه ميكند .

 (AVERAGE(I13:J13, I12:J12
تابع MAX
شكل تابع :(محدوده)=MAX
شرح تابع : بيشترين مقدار محدوده را باز مي گرداند. 

تابع MIN
شكل تابع :(محدوده)=MIN


شرح تابع :كوچكترين مقدار محدوده را باز مي گرداند .

 
تابع MEDIAN
شكل تابع :(محدوده)=MEDIAN
شرح تابع :ميانه محدوده را نمايش ميدهد . 

تابع MODE
شكل تابع (محدوده)=MODE
شرح تابع :داده با بيشترين فراواني را در محدوده نمايش ميدهد .

 
تابع COUNT
شكل تابع (محدوده )=COUNT
شرح تابع :تعداد اعداد موجود در محدوده را نمايش مي‏دهد (سلولهاي را كه شامل اعداد )

مثال: =COUNT(B2:B12)
تابع POWER
شكل تابع =POWER(A,B)
شرح تابع :اين تابع عدد A را به توان Bمي‏رساند .

 تابع SQRT 

شكل تابع = SQRT(A)
شرح تابع :جذر يا ريشه دوم عددمثبت Aرا نمايش مي‏دهد  .

تابع PI
شكل تابع =PI()
شرح تابع :اين تابع عدد پی  را نمايش مي‏دهد .
مثال : اگر دايره‏اي به شعاع 7داشته باشيم مساحت دايره چقدر است ؟  ( مساحت دایره شعاع به توان 2 درعدد پی ) .

=PI()*POWER(7;2)
تابع SIN
شكل تابع (زاويه )=SIN
شرح تابع :اين تابع SINزاويه مورد نظر را نمايش ميدهد . 

اين توابع را ميتوان از طريق INSERT FUNCTION  از منوی Formulas استفاده کرد .

 
 
 
Microsoft Powerpoint
برای شروع کار با PowerPoint . پس از نصب آن باید از منوی Start و منوی فرعی All Programs،منویMicrosoft Office را باز کرده و گزینه Microsoft Office PowerPoint 2010 را انتخاب کنید.
بر روی کلید Start کلید کنید.
روی گزینه All Programs کلیک کنید.
روی گزینه Microsoft Office کلیک کنید.
از منوی باز شده ، گزینه Microsoft Office PowerPoint 2010 را انتخاب کنید
حالا برنامه PowerPoint اجرا شده و شما می توانید محیط آن را مشاهده کنید. قبل از هر چیز بهتر است با قسمت های مختلف این محیط بیشتر آشنا شوید.

قسمتی که با کادر قرمز مشخص شده است،میله ی عنوان برنامه PowerPoint است. در این قسمت نام نمایشی که در حال حاضر باز می باشد، نمایش داده می شود. تا زمانی که شما نامی برای نمایش خود انتخاب نکرده اید، PowerPoint بطور خودکار نام آن را presentation که بعد از آن یک عدد قرار گرفته است، انتخاب می کند. 
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در سمت چپ میله عنوان یک میله ی ابزار ابزار کوچک به نام Quick AccessToolbar قرار گرفته است که شامل ابزار هایی که معمولا زیاد مورد استفاده قرار میگیرند می باشد. شما میتوانید با استفاده از کلید حاوی فلش سیاه رنگ کنار این میله ی ابزار ، ابزارهای مورد نظر خود را به این میله ی ابزار اضافه نمایید.
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کلید File در سمت چپ و بالای صفحه همانند منوی فایل در سایر برنامه ها عمل می کند، با فشردن این کلید، صفحه ای باز می شود که شامل دستوراتی برای مدیریت فایل های PowerPoint می باشد.
قسمتی که توسط کادر قرمز مشخص شده است،مجموعه ی ابزارهای PowerPoint می باشد که به این مجموعهRibbon گفته می شود. Ribbon شامل چندین برگه است که با انتخاب هر برگه ابزار های مربوط به آن برگه نمایش داده می شود. به طور پیش فرض در Ribbon برگه Home فعال می باشد که شامل پر استفاده ترین ابزار هایی است که درطراحی نمایش ها از آنها استفاده می شود.
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برای سادگی کار، برخی از ابزارهای موجود در Ribbon که عملکرد مرتبط به هم دارند در یک گروه دسته بندی شده اند. در حال حاضر شما می توانید گروه ابزارهای Clipboard،Slides،Font،Paragraph,Drawing،Editingرا مشاهده کنید.
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در پایین سمت راست بعضی از گروه ابزارهای موجود در Ribbon یک کلید کوچک حاوی فلش قرار گرفته است. با کلیک بر روی این کلیک کوچک پنجره ای برای دسترسی به سایز گزینه های آن گروه های آن گروه ابزار در اختیار شما قرار می گیرد.
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ابزارهایی که در Ribbon، بصورت کم رنگ نمایش داده می شوند، ابزارهای غیر فعال می باشند که فعلا قابل استفاده نمی باشند. این ابزارها در شرایط خاص و در صورت نیاز فعال می شوند.در شکل تعدادی از ابزار های غیر فعال توسط کادر قرمز مشخص شده اند.
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در سمت چپ محیط PowerPoint،پنجره ای شامل دو برگه بنام های Slides و Outline وجود دارد که در برگه ی Slides پیش نمایشی از اسلاید های موجود و در برگه ی Outline متون موجود در اسلایدهای نمایش داده می شوند.
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قسمتی که توسط کادر قرمز مشخص شده است. محیط طراحی اسلایدهای نمایش می باشد. در این قسمت شما می توانید در هر لحظه یک اسلاید از نمایش را که در برگه Slides یا Outline انتخاب کرده اید مشاهده کرده و آن را ویرایش کنید.
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در پایین محیط کادری وجود دارد که برای اضافه نمودن توضیحات مربوط به اسلاید مورد استفده قرار میگیرد. شما با این قسمت در فصل های آینده بیشتر آشنا خواهیم شد.
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نوار وضیعیت یا Status Bar که در پایین صفحه قرار گرفته است. اطلاعات مختلفی مانند تعداد اسلایدهای نمایش، شماره ی اسلاید فعلی، سبک استفاده شده برای اسلایدها و .... را نمایش می دهد. شما میتوانید با راست کلیک بر روی نوار وضعیت و انتخاب گزینه های مناسب از منوی باز شده، اطلاعات نمایش شده در نوار وضعیت را کنترل کنید.
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در برنامه PowerPoint، به جز دو برگه ی Slides و Outline که در سمت چپ صفحه قرار گرفته اند. چهار نمای دیگرنیز برای نمایش اسلایدها وجود دارند که عبارتند از:Normal View ، Slide Sorter View ، ReadingView و Slide Show، ای چهارنما با استفاده از کلید های کوچک موجود در سمت راست نوار وضعیت که با کادر قرمز مشخص شده اند، قابل دسترس می باشند.
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در انتهای سمت راست نوار وضعیت ابزارهای مزبوط به بزرگ نمایی قرار گرفته است. در این قسمت به ترتیب از چپ به راست سه ابزار بنام های Zoom Level،Zoom Slider، Zoom to Fit قرار گرفته اند که در ادامه با این ابزار ها آشنا می شوید.
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با کلیک بر روی ابزار Zoom Level پنجره ای بر روی صفحه ظاهر می شود که با استفاده از گزینه های موجود در آن می توانید میزان بزرگ نمایی را تعیین کنید.
روی ابزار Zoom Level کلیک کنید.
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پنجره بزرگ نمایی با Zoom گزینه های متعددی را برای بزرگ نمایی در اختیار شما قرار می دهد. قسمت Percentدر این پنجره به شما کمک می کند که بتوانید میزان بزرگ نمایی را به صورت یک عدد بر حسب درصد تعیین کنید. انتخاب یک عدد بزرگتراز %100 موجب عمل بزرگنمایی یا zoom in و انتخاب یک عدد کوجکتر از %100 موجب عمل کوچک نمایی یا Zoom Out می شود. در اینجا ما می خواهیم بزرگ نمایی اسلاید را به دو برابر افزایش دهیم.
روی گزینه %200 کلیک کنید.

[image: image19.png]Blld-v
] Home | et Desgn  Tanstions Anmtions

[F = e sl

Pt o Mew B I U S et A Smapes arange Quice

sige ‘5 7% ses -
cipvons 5 siges - Drawing

‘ Clickto add notes







مشاهده میکنید که بزرگ نمایی اسلاید دو برابر شده است. حالا بهتر است، بزرگ نمایی اسلاید را به حالت قبل بازگردانیم. ولی راه ساده تر استفاده از ابزار Zoom to Fit می باشد. با کلیک بر روی ای ابزار ، بزرگ نمایی اسلاید به گونه ای تغییر میکند که تمام اسلاید در صفحه دیده شود.
روی کلید Zoom to Fit کلیک کنید.
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ابزار دیگریکه در PowerPoint به منظور بزرگ نمایی مورد استفاده قرار می گیرد. ابزار Zoom Slider می باشد که توسط کادر قرمز مشخص شده است. این ابزار شامل یک کلیک لغزان و دو علامت مثبت و منفی در دو طرف آن می باشد که لغزاندن آن به سمت علامت منفی موجب کوچک نمایی اسلاید می شود . همچنین برای بزرگنمایی و کوچک نمایی می توانید مستفیما روی علامت مثبت و منفی نیز کلیک کنید.
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امکانات سربرگ Insert
دراین سربرگ گروه های زیاد و مهمی وجود دارد:
tables:این گروه برای اضافه کردن جدول در ابعاد دلخواه به کار می رود.

 Images:این گروه برای اضافه کردن انواع عکس به نمایش استفاده می شود می شود از عکس های داخل کامپیوتر و عکس های آماده پاور پوبنت وآلبوم عکس استفاده کرد.

هم چنین می توان به وسیله اسکرین شات  از صفحه عکس گرفت و عکس های این
وبلاگ نیز به همین وسیله تهیه شده است.
Illustrations: در این گروه سه بخش مشاهده می شود .بخش اول مربوط به اضافه کردن شکل های آماده است.

بخش دوم مربوط به شکل ها و نمودار ها و هرم ها و ....... است که برای نشان دادن شجره نامه و نمودار های شاخه ای و هرمی و........ به کار می رود.

از قسمت سوم یا چارت برای نمودار های آماری میله ای و شکسته و هرمی و دایره ای و دیگر انواع نمودار ها استفاده می شود.
برای درست کردن نمودار اطلاعات خود را وارد اکسل می کنیم که در این رابطه در
مطالب دیگر وبلاگ بیشتر یاد می گیریم.
Links: به وسیله زیر گروه های این بخش می توانیم به شکل ها و نوشته ها و سایر محتویات پاور پوینت امکانی بدهیم که اگر روی آن کلیک کنیم به یک آدرس اینترنتی و یک فایل و یا یک نمایش دلخواه  ارجاع داده شویم.
Text: در این گروه امکان اضافه کردن نوشته به نمایش و جلوه های نوشتاری  وجود دارد همین طور امکان اضافه کردن سرصفحه و پاصفحه که بعدا با آنها بیشتر آشنا می شویم.
Symbols: در آن میتوانیم فرمول های مختلف وارد کنیم و یا نماد ها و علامت های که در کیبورد وجود ندارد.
Media:در این قسمت می توانیم فایل ویدیویی و صوتی به نمایش اضافه کنیم که می تواند از فایل های کامپیوتر یا فایل های موجود بر وب باشد.
ذخیره سازی و آشنایی با قسمت های دیگر پاورپوینت
تا این مرحله با قسمت های مختلف محیط PowerPoint آشنا شدید، حالا بهتر است یک نمایش که قبلا ایجاد شده است را باز کنید تا با سایر قسمت های PowerPoint نیز آشنا شوید، برای باز کردن یک نمایش می توانید از گزینهOpen واقع در منوی File استفاده کنید.
روی کلید File کلیک کنید.
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از منوی باز شده گزینه Open راانتخاب کنید.
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با انتخاب گزینه ی Open ، پنجره ی Open باز می شود که با استفاده از آن می توانید فایل مورد نظر خود را انتخاب کنید. توجه کنید که سمت چپ این پنجره گزینه های برای دسترسی به شاخه های پر استفاده نظیر Desktop ،Documents و .... وجود دارد.
روی فایل مشخص شده دابل کلیک کنید.
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همانطور که مشاهده می کنید فایل مورد نظر باز شده و اسلایدهای موجود در آن ، در برگه ی Slides واقع در سمت چپ محیط PowerPoint نمایش داده شده اند. حالا بهتر است به محتویات برگه Outline نیز نگاهی بیندازیم.
روی برگه Outline کلیک کنید.
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در برگه Outline می توانید متون موجود در اسلایدها را مشاهده کنید، این برگه برای کار بر روی عناوین و مطالب موجود در اسلایدها بسایر مناسب می باشد.
روی برگه ی Slides کلیک کنید.
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همانطور که قبلا گفته شده، با استفاده از چهار کلید موجود در سمت راست نوار وضیعت می توانید نمای نمایش اسلایدها را تغییر دهید. در PowerPoint در حالت پیش فرض نمای عادی یا Normal فعال می باشد. در نمایNormal در هر زمان تنها یک اسلاید که در برگه ی Slides یا Outline انتخاب شده است. نمایش داده شده و شما می توانید آن را ویرایش کنید.
روی کلید مربوط به نمای Slide Sorter کلیک کنید.
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شما می توانید در نمای Slide Storter، چندین اسلاید از نمایش را همزمان و در کنار هم مشاهده کنید. این نما بیشتر برای عملیاتی از قبیل حذف یا مرتب سازی اسلاید ها و نیز افزودن جلوه های تصویری به اسلایدها مفید می باشد. اکنون به نمای Reading View نگاهی می انداریم.
روی کلید Reading View ، که با فلش مشخص شده است ، کلیک کنید.
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در نمای Reading View ، اسلاید ها به همراه جلوه های تصویرشان به نمایش در می آیند. کلید های موجود در پایین این نما به شما این امکان را می دهند که بتوانید اسلایدهای را مرور کنید.
روی کلید Slide Show ،که با فلش مشخص شده است، کلیک کنید.
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در نمای Slide Show هم مانند نمای Reading View، اسلایدها و جلوه های تصویری به نمایش در می آیند، با این تفاوت که در این نما اسلاید ها بصورت تمام صفحه نمایش داده می شوند. در واقع در این نما، اسلاید ها بصورت تمام صفحه نمایش داده می شوند. برای خروج از این نما باید کلید Esc را فشار دهید و یا از گزینه منویی که با کلیک بر روی آیکون پایین صفحه ظاهر می شود، استفاده نمایید.
کلید Esc را از صفحه کلید فشار دهید.
برای ادامه بهتر به نمای Normal باز گردیم
روی کلید نمای Normal کلیک کنید.
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در PowerPoint می توان اسلاید ها را به صورت سیاه و سفید نیز نمایش داد. برای این منظور از گزینه Black and White واقع در برگه View استفاده کنید.
روی برگه ی View کلیک کنید.
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توجه کنید که این اسلاید چگونه به حالت سیاه و سفید درآمده است.
از این نما می توان به عنوان پیش نمایش چاپ سیاه وسفیداسلاید استفاده کرد. برای رنگی کرئن مجدد اسلاید از کلیدBack to Color View که به Ribbon اضافه شده است استفاده کنید.
روی کلید Back to Color View کلیک کنید.
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در هنگام کار با اسلایدها . برای انتقال به اسلاید های قبلی یا بعدی می توانید از نوار لغزان عمودی که در سمت راست صفحه وجود دارد استفاده کنید، در این حالت در هنگام حرکت بین اسلاید ها،یک کادر توضیح ظاهر میشود که شماره اسلاید در حال نمایش را نشان میدهد. زمانی که عرض یک اسلاید از عرض منطقه نمایش اسلاید بیشتر باشد.یک نوار لغران افقی نیز در پایین ظاهر میشود. شما همچنین میتوانید با کلیک بر روی پیش نمایش اسلایدها در چپ صفحه، اسلاید مورد نظر خود را مشاهده کنید.
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همچنین، با کلیک بر روی کلید های اسلاید قبلی و اسلاید بعدی که در پایین نوار لغزان عمودی قرار دارند میتوانید بین اسلایدها حرکت کنید. البته با استفاده از این کلید ها ، هر بار فقط به اندازه یک اسلایدبه جلو یا عقب جابجا خواهید شد. برای مثال، در حال حاضر اسلاید شماره 1 در حال نمایش میباشد و ما می خواهیم به اندازه یک اسلاید به جلو حرکت کنیم.
بر روی کلید Next Slide، که توسط فلش مشخص شده است، کلیک کنید.
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اکنون همانطور که مشاهده می کنید اسلاید شماره 2 ظاهر شده است. دقت کنید که اسلاید فعلی در برگه Slides با یک حاشیه نارنجی رنگ مشخص شده است.
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راه دیگر برای جابجایی بین اسلاید ها، استفاده از کلید های Page Down و Page Up از صفحه کلید می باشد. بهتر است این روش را هم امتحان کنیم.
کلید Page Up را فشار دهید تا به اسلاید قبل بازگردید.
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به این ترتیب، مجدداسلاید اول نمایش داده شده است. حال که با محیط نرم افزار PowerPoint آشنا شدید. اجازه دهید این نمایش را ذخیره کرده و بعد آن را ببندیم. برای ذخیره سازی یک نمایش،می توانید از دستور Save واقع در صفحه File استفاده کنید و یا بر روی کلید Save از نوار ابزار Quick Access کلیک نمایید.
روی کلید Save کلیک کنید.
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برای بستن یک نمایش، بدون خروج از PowerPoint ، کافیست از صفحه File، گزینه Close را انتخاب کنید.
روی کلید File کلیک کنید.
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در صفحه باز شده گزینه Close را انتخاب کنید.
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 شما می توانید با استفاده از گزینه Save As واقع در صفحه File، از فایل خود یک نسخه پشتیبان نیز تهیه کرده وآن راحتی با یک نام دیگر و در یک محل دیگر ذخیره نمایید.
روی کلید File کلیک کنید.
گزینه Save As را انتخاب کنید.
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اکنون پنجره Save As باز شده است.این پنجره دارای گزینه های زیادی برای ذخیره سازی و ساماندهی فایل ها و پوشه ها می باشد. نمای ظاهری این پنجره مانند پنجره Open است اما از پنجره Save As برای مقاصد دیگری استفاده میشود.برای مثال ، شما میتوانیدیک کپی پشتیبان از فایل نمایش خود تهیه کنیدو آن را بعنوان پایه ای برای نمایشهای دیگر مورد استفاده قرار دهید. 
موفق باشید
Rahmani
Single   حالت پیش فرض


1.5 lines  1.5 برار


Double  دو برابر


At least  حداقل


Exactly  اندازه دقیق


Multiple چند حالته








Line Spacing





First line تو رفتگی برای خط اول پاراگراف


Hanging  تورفتگی مربوط به خطوط دیگر پاراگراف





Before  فاصله از پاراگراف قبلی


After فاصله از پاراگراف بعدی





Automatic معمولی


Grayscale   تصویر خاکستری 


Black & white تصویر سیاه و سفید 


Washout   تصویر مات 
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